GIS-BASED EARLY WARNING SYSTEM FOR PREDICTING HIGH-RISK AREAS
OF DENGUE VIRUS TRANSMISSION, RIBEIRÃO PRETO, BRAZIL

By
Ryan Marc Carney

A Thesis Presented to
The Faculty of the Yale School of Public Health
Yale University

In Candidacy for the Degree of
Master of Public Health

2010
Abstract

Dengue virus (DENV) is currently the most rapidly spreading vector-borne disease, with an estimated 50-100 million infections per year and 2.5 billion people – 40% of the world’s population – at risk of infection. Since 1990, the city of Ribeirão Preto (pop. 563,000), Brazil, has experienced DENV epidemics of increasing severity, including the largest epidemic to date in 2010 (=13,000 cases as of April 22). However, there are no vaccines or treatments for DENV, and the only method for reducing morbidity and mortality is through control of the principal mosquito vector, *Aedes aegypti*. To inform surveillance and control efforts in Ribeirão Preto, a geographic information system (GIS) was created along with an address locator for geocoding dengue cases. The primary objective of this study was to investigate the utility of modifying a West Nile virus early warning system, used successfully in California to predict and prevent human cases, that models viral amplification using a localized Knox test and Monte Carlo simulation approach based on parameters of vector and host biology. Results from this study, which represents the first spatially explicit model that uses human cases to predict future dengue risk, indicate that the modified DYCAST system provided early and accurate identification of high-risk areas in Ribeirão Preto, including detection of what appears to be the cryptic interepidemic focus of transmission that later developed into the severe 2006 epidemic. During the study period, DYCAST predicted up to 90.3% (4,234/4,690) of cases, at a maximum mean of 66.3 days prior to onset of illness. Maximum sensitivity and specificity was 83.8% and 78.8%, respectively, and relative risk of DENV infection was >10x higher in cells identified as high risk. Additionally, model efficacy was retained and even enhanced by including unconfirmed dengue cases in the analysis, which has important implications for increasing the utility and applicability of the model. These findings suggest that the DYCAST system could be utilized prospectively and in real-time to identify areas at high risk of DENV transmission, in order to target mosquito control, surveillance, and public education campaigns in a timely, efficient, and cost-effective manner. Furthermore, and in a departure from previous studies, this risk model was implemented using free, open-source, and cross-platform software that could provide an inexpensive and scalable GIS solution for the surveillance and control of DENV – and potentially other infectious diseases – by Ribeirão Preto and other public health agencies in the future. Protocols for generating the spatial datasets and installing the various software components are also provided.
Acknowledgments

I would particularly like to thank my academic and thesis advisor, Durland Fish, PhD (Yale University), for his valuable direction and insight, as well as my preceptor Benedito Antônio Lopes da Fonseca, MD, PhD, MPH (Universidade de São Paulo) and colleague André Markon, MPH (University of Michigan) for their exceptional assistance during my summer internship. I would like to thank my thesis reader Maria Diuk-Wasser, PhD (Yale University) and professor Ted Holford, PhD (Yale University) for helpful comments and feedback, and acknowledge the author of the open source DYCAST scripts, Alan McConchie, MS (University of British Columbia). For their assistance in providing data and information used in this study, I would like to thank Marcelo Raspa, Claudio Souza de Paula, MD, and Maria Luiza, MD, from Secretaria Municipal de Saúde; Antônio Pazin Filho, MD from Universidade de São Paulo; and Wilson Yong from Companhia de Desenvolvimento Economico de Ribeirão Preto.

Funding for this research was provided through a US Centers for Disease Control and Prevention Training Grant Master of Public Health Fellowship.
# Table of Contents

1. **Introduction**
   a. Statement of general problem addressed by the thesis.................. 8–10
   b. Objectives................................................................................. 10–11
   c. Relevant studies....................................................................... 11–12

2. **Methods**
   a. Data......................................................................................... 13–15
   b. Risk model
      i. Software................................................................................. 15–16
      ii. Procedure............................................................................ 17–19
      iii. Calibration........................................................................ 19–20
      iv. Evaluation.......................................................................... 20–21

3. **Results**
   a. Calibration............................................................................. 22–26
   b. Evaluation............................................................................... 26–29

4. **Discussion**
   a. Summary of findings.............................................................. 30
   b. Significance of findings, assessment of applyability to current theory and practice.......................... 31–36
   c. Limitations of study and findings........................................ 36–38
   d. Relevant recommendations..................................................... 38–41

6. **References.............................................................................. 42–47

7. **Appendices**
   I. Protocol – software installation, modification, FAQ.............. 48–57
   II. Protocol – geocoding................................................................. 58–71
   III. Protocol – grid creation.......................................................... 72–75
   IV. Protocol – DYCAST, ArcMap analysis.................................... 76–82
List of Tables

Table 1. Number of confirmed dengue cases, Ribeirão Preto
Table 2. DYCAST model parameters
Table 3. Sensitivity analysis of geocoding parameters, composite address locator
Table 4. Model results, 2005 Jul 1–2006 Jun 30, Ribeirão Preto
Table 5. Confusion matrices comparing number of cells that contained dengue case(s) and number of cells identified as high risk by models, 2005 Jul 1–2006 Jun 30, Ribeirão Preto
List of Figures

**Figure 1.** Current mapping methods used in Ribeirão Preto for dengue surveillance and control.

**Figure 2.** Geocoding process in ArcView 9.3.0.

**Figure 3.** Schematic of free and open source software used to implement the DYCAST model.

**Figure 4.** Schematic of the dengue virus DYCAST procedure.

**Figure 5.** Average monthly temperatures, Ribeirão Preto, 2003-2009.

**Figure 6.** Dengue cases in Ribeirão Preto per week, by year.

**Figure 7.** Map illustrating dengue cases (black circles) and high-risk cells generated at analysis thresholds 1–15 for Jan 31, 2006, Ribeirão Preto.

**Figure 8.** Graph illustrating number of high-risk cells, maximum p-value, and proportion of p-values $\leq \alpha (0.1)$ for high-risk cells generated at analysis thresholds 1–15 for Jan 31, 2006, Ribeirão Preto.

**Figure 9.** Receiver operating characteristic (ROC) plot for models D10, D05, and D10’.

**Figure 10.** Number of confirmed dengue cases and DYCAST cells identified as high risk by models D10 (red), D05 (orange), and D10’ (yellow) per day, Ribeirão Preto, Jul 1, 2005–Jun 30, 2006.

**Figure 11.** Confirmed dengue cases and DYCAST risk maps displaying high-risk cells as identified by models D10 (red), D05 (orange), and D10’ (yellow), Ribeirão Preto.

**Figure 12.** Number of suspected cases confirmed (red) and unconfirmed (green) for dengue infection per year, 1998-2009, Ribeirão Preto.
Body of the Thesis

i. Thesis Type:  *Research Study Demonstrating Mastery of Methodology*

ii. Article Summary Line

The DYCAST early warning system was effective at identifying areas at high risk of dengue virus transmission during epidemic and interepidemic periods.

iii. Running Title

Dynamic early warning system for dengue virus

iv. Keywords

arboviruses, Brazil, dengue virus, disease outbreaks, geographic information systems, humans, insect vectors, mosquitoes, surveillance, transmission
Introduction

Statement of general problem addressed by the thesis

Dengue virus (DENV; genus Flavivirus, family Flaviviridae) is currently the fastest-spreading vector borne disease, with an estimated 50-100 million infections per year and 2.5 billion people – 40% of the world’s population – at risk of infection (1,2). Exacerbated by growing trends of urbanization and environmental perturbation, this tremendous global disease burden falls almost exclusively on developing countries, which generally lack the resources and infrastructure for sufficient surveillance and control of the virus. While most DENV illnesses are asymptomatic or develop into the mild form of the disease, classic dengue fever (DF), approximately 3% of illnesses develop into dengue hemorrhagic fever (DHF) and dengue shock syndrome (DSS), with mortality rates over 10% (3-5). These severe forms of illness are due to antibody-dependent enhancement (ADE) caused by subsequent infection with one of the other four dengue serotypes (DENV-1, -2, -3, and -4). However, there are no vaccines or treatments available for dengue, therefore the only method for reducing human morbidity and mortality is through control of the principal mosquito vector, Aedes aegypti. Thus, there is an acute need for an early warning system to target such prevention and control efforts, and in particular, to identify areas where the virus is cryptically maintained during interepidemic periods (6).

From 1990-1991, the first dengue epidemic occurred in Riberão Preto (652 km²; population: 563,000), a northern city in the State of São Paulo, Brazil. During this outbreak there were 8,900 reported cases (7), and a survey conducted in 1992 detected
5.4% seroprevalance for DENV-1 IgG antibodies among participating residents (8).

DENV-2 and -3 were detected in 1998 and 2001, respectively, with the latter triggering a large epidemic during that same year (Benedito Antônio Lopes da Fonseca, University of São Paulo, pers. comm.). Currently, DENV-3 is the predominant serotype within Riberão Preto, which has experienced epidemics of increasing severity (Table 1), including the largest epidemic to date in 2010 (~13,000 confirmed cases as of April 22; 9). Vector control efforts are initiated in the city once the monthly incidence rate exceeds the average rate from the previous 10 non-epidemic years (Claudio Souza de Paula, Secretaria Municipal de Saúde, pers. comm.). However, this practice only provides a temporal threshold for epidemic control, and ignores the spatial aspects of dengue transmission. Complicating surveillance and control efforts is the fact that the health departments and vector control agency have relied exclusively on paper-based mapping of cases and vector data (Figure 1a,b).

<table>
<thead>
<tr>
<th>Year</th>
<th>Total cases</th>
<th>Classic dengue</th>
<th>Dengue with complications</th>
<th>DHF</th>
<th>DSS</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010*</td>
<td>12,933</td>
<td>-</td>
<td>-</td>
<td>31</td>
<td>-</td>
</tr>
<tr>
<td>2009</td>
<td>1,685</td>
<td>1,671</td>
<td>5</td>
<td>9</td>
<td>0</td>
</tr>
<tr>
<td>2008</td>
<td>1,073</td>
<td>1,066</td>
<td>3</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>2007</td>
<td>2,752</td>
<td>2,733</td>
<td>15</td>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>2006</td>
<td>6,051</td>
<td>6,026</td>
<td>11</td>
<td>13</td>
<td>1</td>
</tr>
<tr>
<td>2005</td>
<td>645</td>
<td>639</td>
<td>1</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>2004</td>
<td>50</td>
<td>50</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2003</td>
<td>808</td>
<td>800</td>
<td>0</td>
<td>8</td>
<td>0</td>
</tr>
<tr>
<td>2002</td>
<td>360</td>
<td>360</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2001</td>
<td>3,217</td>
<td>3,216</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>2000</td>
<td>211</td>
<td>211</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1999</td>
<td>320</td>
<td>320</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1998</td>
<td>268</td>
<td>268</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Total</td>
<td>17,440</td>
<td>17,360</td>
<td>35</td>
<td>42</td>
<td>3</td>
</tr>
</tbody>
</table>

*Boldface denotes years of critical transmission, defined by the Brazilian Ministry of Health as incidence rates >300 per 100,000 (de Paula, pers. comm.)

*As of April 22, 2010 (9)
Figure 1. Current mapping methods used in Ribeirão Preto for dengue surveillance and control. a. color-coded push pins used to plot dengue cases in one of the health districts (2007), and b. one of dozens of papers comprising a map of the city used to track and plan for mosquito surveillance and control.

Objectives

The objectives of this study were threefold. First, this study aimed to create a comprehensive GIS that could be utilized by local agencies in Ribeirão Preto for the surveillance and control of dengue, and in particular, a means to geocode the addresses of dengue cases for mapping purposes. Second, these spatial datasets would be used to implement a dengue risk model, which would be evaluated for use as a prospective, early warning system in Ribeirão Preto. The third objective was to use this model to detect cryptic transmission foci responsible for interepidemic maintainence of the virus during
the dry season, which would be valuable for targeting mosquito control efforts to interrupt transmission prior to reemergence of epidemic amplification.

**Relevant Studies**

The majority of research on DENV transmission has focused on the epidemic periods of the disease, ignoring interepidemic transmission that nonetheless contributes considerable disease burden through productivity loss and absenteeism (1). What is known is that this phenomenon appears to be driven more by intrinsic population dynamics of the vector than extrinsic factors such as climate (6), suggesting that modeling efforts should concentrate more on intra-seasonal instead of inter-seasonal factors. However, in addition to numerous methodological shortcomings of using immature mosquito indices to predict risk of human infection (10), the vector surveillance data collected in Ribeirão Preto is prohibitive for using existing dengue transmission models (11,12) due to the entomological stage sampled (larval instead of pupal) and spatial scale at which data is aggregated (data not shown). Other researchers have used various spatial and spatiotemporal methods to characterize distributions of human cases (13-16), however all of these models have been only descriptive in nature and do not provide any statistical means for assessing future risk of dengue transmission. However, previous studies have shown the Dynamic Continuous-Area Space-Time (DYCAST) model to be successful as an early warning system for the related mosquito-borne flavivirus, West Nile virus (WNV). DYCAST identifies area at high risk of WNV transmission to humans by using statistical analysis of public reports of dead birds, based on biological parameters of *Culex* spp. mosquito vectors and avian hosts.
This model was first implemented, retrospectively, in New York City in 2000 and Chicago in 2001, and implemented prospectively in California since 2005 as an early warning system (17-19). In California, DYCAST has been used to assist mosquito larviciding and adulticiding efforts (20), including emergency aerial mosquito control conducted during an unprecedented epidemic in 2005, which has been shown to have reduced human morbidity and potentially mortality from WNV infection (21). Given these successful results implementing DYCAST as an early warning system for a related arboviral disease, this model was selected for the present study and adapted for use as a dengue risk model.
Methods

Data

Excel (Microsoft Corporation, Redmond, WA, USA) databases containing records of all suspected dengue cases (n=53,256) in Ribeirão Preto from January 1, 1998 through January 25, 2010 were obtained from the Ribeirão Preto Municipal Health District’s Division of Epidemiological Surveillance (Divisão de Vigilância Epidemiológica. Secretaria Municipal de Saúde de Ribeirão Preto). Information included residential address, date of onset of illness, and clinical diagnosis of confirmed (n=17,440; Table 1) and unconfirmed (n=35,816) dengue cases. These data were scrubbed and integrated into a single Excel database, and the confirmed cases used to plot case incidence by week in order to assess seasonality of epidemic and interepidemic periods. Locations of all suspected cases were mapped by using ArcView 9.3.0 (Environmental Systems Research Institute, Inc.; ESRI, Redlands, CA, USA) and a composite address locator to geocode records based on street address, Código de Endereçamento Postal (CEP; zip code), and bairro (district) (Figure 2a); this locator was built by using a line shapefile containing street reference data for Ribeirão Preto and a Brazilian-formatted locator index, both obtained from ESRI (see Appendix). One source of spatial inaccuracy in geocoding address data is the offset value used to specify distance of residences from the centerline of their respective street, which can vary greatly between rural and urban areas. Thus, an appropriate offset was derived using empirical data, which consisted of 11,909 suspected dengue cases in Ribeirão Preto, from approximately January 1, 2007 through May 31, 2008, that had been previously
georeferenced to centroids (center) of residential lots by Companhia de Desenvolvimento Economico de Ribeirão Preto (CODERP; Wilson Yong, unpub. data). The median distance between cases and their respective street centerline was then obtained (Figure 2b; see Appendix); cases >100 m from a street centerline were excluded, as these represented addresses not included in the street reference data. The mean offset value was used in all subsequent geocoding processes.

![Geocoding process in ArcView 9.3.0.](image)

**Figure 2.** Geocoding process in ArcView 9.3.0. a. Código de Endereçamento Postal (CEP; zip code)-based address locator, illustrating matching parameters (“Matching Options”) and side offset (red box); b. raster layer of distances from street centerline (from green to red) sampled by cases (blue circles) to calculate median offset.

Selection of address locator matching parameters (spelling sensitivity, minimum candidate score, and minimum matching score) was made through a step-wise sensitivity analysis. This included comparing geocoding results from all suspected cases, using both
individual address locators and 14 combinations of parameters with the composite locator (see Appendix). An optimal parameter set was selected by examining results for accuracy. Approximately half (n=7,500) of the unmatched records were then manually rematched; findings from this process were then used to automatically rematch the remainder. Pearson correlation was used to test whether the percentage of successfully matched addresses changed over time, which might indicate changes in data quality or the presence of addresses in areas not represented by street reference data.

**Risk model**

**Software**

In previous studies, the DYCAST model was implemented by using expensive and specialized GIS software, Smallworld 3.2.1 (General Electric Company, Fairfield, CT, USA), and its proprietary Magik computer programming language (17-19). More recently, the model has been recreated by using the widely used computer programming language, Python (www.python.org), which provides for the implementation of the model using free, open source, and cross-platform (Windows and Mac operating systems) software (Alan McConchie, University of British Columbia, unpub. data). The present study implemented this open source version of the model on a 64-bit Windows Vista Business Edition platform (Microsoft Corp.). DYCAST scripts were modified in order to run the model using dengue-specific parameters and the spatial reference appropriate for the study region (see Appendix); scripts were executed using Python 2.6. Psychopg 2.0.14 (www.initd.org/psycopg) provided porting to PostgreSQL 8.4.3 object-relational database management system (www.postgresql.org); a graphical user interface (GUI) was
provided by pgAdminIII (Figure 3). Support for geographic objects was added by using PostGIS 1.5.1 ([www.postgis.org](http://www.postgis.org)) and shp2pgsql graphical loader plugin. The model’s analysis grid, risk maps, and animations were created by using ArcView 9.3.0, along with its Spatial Analyst and Tracking Analyst extensions (see Appendix). While ArcView is commercial software, these operations could be accomplished in future implementations by using the free and open source GIS software, Geographic Resources Analysis Support System GIS (GRASS GIS; [grass.osgeo.org](http://grass.osgeo.org)).

Figure 3. Schematic of free and open source software used to implement the DYCAST model. Commercial ArcGIS software (i.e., ArcView) was used in this study to create spatial datasets; however, this could be accomplished in future implementations by using free and open source GIS software, GRASS GIS.
Procedure

A digital map of Ribeirão Preto was superimposed with a grid consisting of 71,824 1-hectare (0.01 km²) cells. A localized Knox test (22-23) was implemented from the centroid of each cell for which the number of dengue cases within the spatial and temporal domains met or exceeded the analysis threshold (see below). The radius of the spatial domain was based on a 600 m maximum flight range of *Ae. aegypti* (24,25), a distance which fell within estimates of 200 m (26) and 800 m (27) derived from suburban and urban field studies in Rio de Janeiro, Brazil using laboratory-raised mosquitoes. The 28-day temporal domain represented one complete human-vector-human infection cycle (Figure 4); this accounted for a 10-day extrinsic incubation period of DENV in *Ae. aegypti* (28-30) and two human infection cycles of 9 days each, which consist of a 6-day intrinsic incubation period (31-32) and a 3-day infectious symptomatic period (32). These bounds define the spatiotemporal domain, within which cases were analyzed for close pairing in space and time. Closeness in space was defined as 100 m, to encompass the mean flight range of *Ae. aegypti* (26,24,33,34). Closeness in time was defined as 4 days, and represented the length of the *Ae. aegypti* gonotrophic cycle based on field (35,36) and laboratory (33,37) findings at temperatures consistent with those in Ribeirão Preto (Figure 5). Statistical significance of case pairing was assessed by using unconditional Monte Carlo simulations (18,38). P-values denote the probability that clustering in space and time is caused by random chance; high-risk was defined at $\alpha=0.1$ in accordance with previous DYCAST models (17-19). This procedure was repeated at each centroid to create an interpolated surface of risk. Parameters used in the WNV and DENV models are shown in Table 2 for comparison purposes.
Figure 4. Schematic of the dengue virus DYCAST procedure, illustrating domains of localized Knox test implemented at the centroid of an individual 1-hectare grid cell (grid not to scale). The radius of the ≈113-hectare (1.13 km²) spatial domain is based on the maximum flight range of *Aedes aegypti*, and the 28-day temporal domain accounts for the extrinsic incubation period of DENV and two human infection cycles. These bounds define the spatiotemporal domain, within which cases (asterisks) were analyzed for close pairing in space (100 m) and time (4 days) (small white cylinder). Statistical significance of case pairing was assessed by using unconditional Monte Carlo simulations ($\alpha=0.1$).
Figure 5. Average monthly temperatures, Ribeirão Preto, 2003-2009. Data source: Centro Integrado e Informações Agrometeorológicas (http://www.ciiagro.sp.gov.br/ciiagroonline/Listagens/MonClim/LMClimLocal.asp)

Table 2. DYCAST model parameters

<table>
<thead>
<tr>
<th>Virus model</th>
<th>Spatial domain (m)</th>
<th>Spatial closeness (m)</th>
<th>Temporal domain (days)</th>
<th>Temporal closeness (days)</th>
<th>Threshold (number reports)</th>
</tr>
</thead>
<tbody>
<tr>
<td>West Nile</td>
<td>2,410</td>
<td>402</td>
<td>21</td>
<td>3</td>
<td>15</td>
</tr>
<tr>
<td>dengue</td>
<td>600</td>
<td>100</td>
<td>28</td>
<td>4</td>
<td>10,5</td>
</tr>
</tbody>
</table>

*West Nile virus parameters taken from (19).

Calibration

In order to determine an appropriate analysis threshold value, a sensitivity analysis was conducted for a date representative of an incipient epidemic (January 31, 2006). This included examinations of high-risk areas and p-value distributions generated by the DYCAST model at thresholds of 1 through 15. Optimal threshold(s) were subsequently used to run risk for the duration of the study period, for which year 2006 was selected as it represented the largest dengue epidemic in Ribeirão Preto to date
(excluding the current 2010 epidemic). The preceding interepidemic period in 2005 was also included in the study period, the exact date of which was determined by examination of case incidence to validate current temporal definitions. In Ribeirão Preto, the interepidemic period is officially defined as July 1 through October 31 of each year, approximately weeks 27 through 43 (Maria Luiza, Secretaria Municipal de Saúde de Ribeirão Preto, pers. comm.); ecologically, this coincides with the rainy season that begins around November (de Paula, pers. comm).

**Evaluation**

Results from the risk models were analyzed by using ArcMap, Excel:mac 2008 version 12.2.4, and StatPlus:mac LE 2009 version 5.8.0.0 (AnalystSoft, Inc., Vancouver, BC, Canada). Prediction was defined as the identification of a cell as high risk prior to or on the date of onset of illness of the earliest confirmed case located within that cell. If a cell was identified as high risk after the date of onset of illness, or the cell was never identified as high risk and a case occurred within it, it was designated false negative. Out of the total area analyzed, cells considered to be potentially at risk were those within 618.44 m of street reference data. This distance was based on the model’s 600 m spatial domain plus the 18.44 m geocoding side offset (see below), and represented the maximum distance from the street centerline that a cell could be identified as high-risk. This provided for a more conservative estimate of the true negative rate (and thus validity indices) by eliminating areas of the city where cases could not be mapped, and resulted in a study region of 25,487 cells, a total of 254.9 km².
Results were used to calculate metrics of model efficacy, such as prediction rates and number of days prior to onset of illness that cases were predicted. Confusion matrices were also constructed to compare number of cells that contained dengue cases and number of cells identified as high risk by each model. These were used to generate measures of validity and association, including sensitivity, specificity, Youden’s J, positive (PPV) and negative predictive values (NPV), classification accuracy, relative risk (RR), and kappa statistic of chance-adjusted agreement (39). Because kappa is highly sensitive to both prevalence and classification bias, a prevalence-adjusted, bias-adjusted kappa statistic was used (PABAK; 40). Results were also used to generate receiver operating characteristic (ROC) plots, and the area under the ROC curve (AUC) was estimated nonparametrically by using the Wilcoxon rank-sum statistic (41).
Results

Calibration

Results of weekly incidence plotted by year confirm the validity of the July 1 through October 31 temporal bounds of the interepidemic period; specifically, week 44 corresponds to increased incidence rates in 2005 and 2009 (Figure 6, inset), which preceded the unprecedented epidemics of 2006 and 2010. Thus, July 1, 2005 through June 30, 2006 was selected as the duration for the model study period.

Figure 6. Dengue cases in Ribeirão Preto per week, by year. Average is the mean case incidence over the 12 years shown; average in the inset does not include 2005 and 2009 data, however. Inset x-axis has the same scale, Jul 1–Dec 31; inset y-axes have the same units (cases).
Geocoding offset analysis yielded a mean distance of 18.44 m (60.50 feet) from residential lot centroid to street centerline; this value was used as the side offset value in the subsequent geocoding of dengue cases (Figure 2a). The composite locator provided a 1.0% increase in matched records compared to geocoding using the CEP locator alone. Findings from the sensitivity analysis indicated that out of the 14 different combinations of matching parameters, 60, 10, and 23 was the optimal combination of spelling sensitivity, minimum candidate score, and minimum match score, respectively (Table 3, see Appendix). Lowering the spelling sensitivity below 60 increased the number of inaccurate matches, due to a greater number of tied records (which are considered matches) that would otherwise be classified as unmatched. Subsequent manual examination and rematching of unmatched records indicated that the optimal parameter combination should be modified further to 60, 10, and 10, respectively. This rematching process also increased the total number of matched records by 1.2%, to 73.2%. Results

<table>
<thead>
<tr>
<th>Parameters</th>
<th>% total matched</th>
<th>Number matched</th>
<th>Number tied</th>
<th>Number unmatched</th>
</tr>
</thead>
<tbody>
<tr>
<td>80-10-60†</td>
<td>57.4%</td>
<td>30,006 (56%)</td>
<td>589 (1%)</td>
<td>22,661 (43%)</td>
</tr>
<tr>
<td>80-10-60‡</td>
<td>14%</td>
<td>7,488 (14%)</td>
<td>124 (0%)</td>
<td>45,644 (86%)</td>
</tr>
<tr>
<td>80-10-60</td>
<td>58%</td>
<td>30,503 (57%)</td>
<td>598 (1%)</td>
<td>22,155 (42%)</td>
</tr>
<tr>
<td>40-10-60</td>
<td>59%</td>
<td>30,958 (58%)</td>
<td>606 (1%)</td>
<td>21,692 (41%)</td>
</tr>
<tr>
<td>40-10-30</td>
<td>68%</td>
<td>35,866 (67%)</td>
<td>777 (1%)</td>
<td>16,613 (31%)</td>
</tr>
<tr>
<td>80-10-23</td>
<td>64%</td>
<td>35,732 (62%)</td>
<td>903 (2%)</td>
<td>16,621 (31%)</td>
</tr>
<tr>
<td>60-10-23</td>
<td>72%</td>
<td>37,544 (70%)</td>
<td>940 (2%)</td>
<td>14,772 (28%)</td>
</tr>
<tr>
<td>50-10-23</td>
<td>74%</td>
<td>38,486 (72%)</td>
<td>1,071 (2%)</td>
<td>13,700 (26%)</td>
</tr>
<tr>
<td>40-10-23</td>
<td>76%</td>
<td>39,114 (73%)</td>
<td>1,558 (3%)</td>
<td>12,584 (24%)</td>
</tr>
<tr>
<td>20-10-23</td>
<td>81%</td>
<td>39,474 (74%)</td>
<td>3,529 (7%)</td>
<td>10,253 (19%)</td>
</tr>
<tr>
<td>40-10-15</td>
<td>77%</td>
<td>39,420 (74%)</td>
<td>1,573 (3%)</td>
<td>12,263 (23%)</td>
</tr>
<tr>
<td>20-10-15</td>
<td>82%</td>
<td>39,800 (75%)</td>
<td>3,551 (7%)</td>
<td>9,905 (19%)</td>
</tr>
<tr>
<td>20-5-15</td>
<td>82%</td>
<td>39,800 (75%)</td>
<td>3,551 (7%)</td>
<td>9,905 (19%)</td>
</tr>
<tr>
<td>20-5-5</td>
<td>82%</td>
<td>40,073 (75%)</td>
<td>3,566 (7%)</td>
<td>9,615 (18%)</td>
</tr>
<tr>
<td>5-5-5</td>
<td>84%</td>
<td>39,893 (75%)</td>
<td>4,618 (9%)</td>
<td>8,745 (16%)</td>
</tr>
<tr>
<td>0-0</td>
<td>88%</td>
<td>40,352 (76%)</td>
<td>6,490 (12%)</td>
<td>6,414 (12%)</td>
</tr>
</tbody>
</table>

*Spelling sensitivity, Minimum candidate score, and Minimum match score, respectively. Default values are 80-10-60.†CEP (zip code)-based address locator (individual)‡Bairro (district)-based address locator (individual)
from the Pearson correlation test indicated no significant linear correlation between percentage of geocode matches and year (p=0.1174, R=-0.47644).

Results from the threshold sensitivity analysis indicated the occurrence of false positives and pair dependencies at low threshold numbers, which is an inherent statistical artifact of the Monte Carlo distributions. At a threshold of 2, for example, high-risk cells were predicted around every pair of cases (Figure 7). However, this effect was eliminated at thresholds ≥10, which resulted in all high-risk cell p-values ≤ α of 0.1 (Figure 8). Thus, a threshold of 10 was used for the initial risk model, D10. Additionally, in order to investigate the utility of using a lower threshold to increase sensitivity of the model during interepidemic periods, a threshold of 5 was used for a second risk model, D05. This threshold was based on an acceptable proportion of high-risk cell p-values ≤ α (88.1%; 998 of 1,133 cells), as well as qualitative examination of the risk maps, which indicated a sufficient balance of over- and under-prediction of risk at this threshold (Figure 7, Figure 8). A third model (D10’) was also run which used as its input all suspected cases of dengue, which included 4,496 unconfirmed cases in addition to the 4,960 confirmed cases used in the other models. The purpose of this iteration was to evaluate the effect that using raw syndromic surveillance data would have on the model’s efficacy.
Figure 7. Map illustrating dengue cases (black circles) and high-risk cells generated at analysis thresholds 1–15 for Jan 31, 2006, Ribeirão Preto. Cases displayed are those with an onset of illness between Jan 3–Jan 31; this corresponds to the 28-day temporal domain of the model and thus includes all cases contributing to risk at that time.

Figure 8. Graph illustrating number of high-risk cells, maximum p-value, and proportion of p-values ≤ α (0.1) for high-risk cells generated at analysis thresholds 1–15 for Jan 31, 2006, Ribeirão Preto.

Evaluation

Models D10’, D05, and D10 first identified cells as high-risk on July 6, 14, and October 31; overall, cells were identified as high risk for a mean total of 92.3, 83.8, and 65.4 days, respectively (Table 4). During the study period there were 4,690 confirmed dengue cases, of which a maximum 90.3% (4,237/4,690) was predicted by the models at a mean of 66.3 days prior to onset of illness (D10’). Validity indices derived from confusion matrices (Table 5) yielded maximum sensitivity of 83.8% (D10’) and maximum specificity of 78.8% (D10); model D10’ exhibited the highest Youden’s J statistic, 0.561. Both measures of agreement, accuracy (0.777) and kappa (0.554), as well as PPV (24.2%), were highest in D10; NPV was highest in D10’ (97.8%). All three RR values differed significantly from unity, with a maximum of 10.569 (95% CI 9.498–11.760, p<0.0001) for D10’. ROC analysis yielded an AUC of 0.783 (Figure 9); given the similar results obtained by D05 and D10’, exclusion of the latter from the calculation yielded a virtually equivalent AUC of 0.780.
Table 4. Model results, 2005 Jul 1–2006 Jun 30, Ribeirão Preto

<table>
<thead>
<tr>
<th>Cells</th>
<th>D10</th>
<th>D05</th>
<th>D10'</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date of first high-risk cell</td>
<td>Oct 31</td>
<td>Jul 14</td>
<td>Jul 6</td>
</tr>
<tr>
<td>% high-risk cells (out of 25,487)</td>
<td>27.7%</td>
<td>34.9%</td>
<td>34.0%</td>
</tr>
<tr>
<td>No. high-risk cells</td>
<td>7,062</td>
<td>8,899</td>
<td>8,660</td>
</tr>
<tr>
<td>No. days cells identified high risk</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>mean</td>
<td>65.4</td>
<td>83.8</td>
<td>92.3</td>
</tr>
<tr>
<td>std dev</td>
<td>38.9</td>
<td>46.1</td>
<td>47.8</td>
</tr>
<tr>
<td>median</td>
<td>62</td>
<td>83</td>
<td>95</td>
</tr>
<tr>
<td>max</td>
<td>199</td>
<td>242</td>
<td>243</td>
</tr>
<tr>
<td>Cases</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prediction rate (out of 4,690)</td>
<td>79.1%</td>
<td>90.3%</td>
<td>90.3%</td>
</tr>
<tr>
<td>No. cases predicted</td>
<td>3,710</td>
<td>4,234</td>
<td>4,237</td>
</tr>
<tr>
<td>No. days predicted prior to onset</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>mean</td>
<td>48.0</td>
<td>62.5</td>
<td>66.3</td>
</tr>
<tr>
<td>std dev</td>
<td>35.6</td>
<td>41.4</td>
<td>41.0</td>
</tr>
<tr>
<td>median</td>
<td>42</td>
<td>57</td>
<td>61</td>
</tr>
<tr>
<td>max</td>
<td>234</td>
<td>304</td>
<td>315</td>
</tr>
<tr>
<td>Validity, association†</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sensitivity</td>
<td>67.1%</td>
<td>83.1%</td>
<td>83.8%</td>
</tr>
<tr>
<td>Specificity</td>
<td>75.8%</td>
<td>71.3%</td>
<td>72.3%</td>
</tr>
<tr>
<td>Youden’s J</td>
<td>0.458</td>
<td>0.544</td>
<td>0.561</td>
</tr>
<tr>
<td>Accuracy</td>
<td>0.777</td>
<td>0.724</td>
<td>0.734</td>
</tr>
<tr>
<td>Kappa (PABAK)‡</td>
<td>0.554</td>
<td>0.447</td>
<td>0.467</td>
</tr>
<tr>
<td>Positive predictive value</td>
<td>24.2%</td>
<td>22.6%</td>
<td>23.4%</td>
</tr>
<tr>
<td>Negative predictive value</td>
<td>95.9%</td>
<td>97.7%</td>
<td>97.8%</td>
</tr>
<tr>
<td>Relative risk</td>
<td>5.969</td>
<td>9.704</td>
<td>10.569</td>
</tr>
<tr>
<td>95% CI, lower limit</td>
<td>5.502</td>
<td>8.735</td>
<td>9.498</td>
</tr>
<tr>
<td>95% CI, upper limit</td>
<td>6.476</td>
<td>10.779</td>
<td>11.760</td>
</tr>
</tbody>
</table>

Boldface denotes optimal value of the three models.

*TH10 and TH05 used confirmed dengue cases (n=4,690) and a threshold of 5 and 10, respectively; TH10' used suspected dengue cases (n=9,186; both confirmed and non-confirmed cases) and a threshold of 10.

†Calculated from confusion matrix (Table 5; 39).

‡Prevalence-adjusted, bias-adjusted kappa (40).

Figure 9. Receiver operating characteristic (ROC) plot for models D10, D05, and D10'. Area under the ROC curve (AUC) is equal to 0.783.

Table 5. Confusion matrices comparing number of cells that contained dengue case(s) and number of cells identified as high risk by models, 2005 Jul 1–2006 Jun 30, Ribeirão Preto*

<table>
<thead>
<tr>
<th></th>
<th>D10</th>
<th>D05</th>
<th>D10'</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Contained case Yes</td>
<td>No</td>
<td>Total</td>
</tr>
<tr>
<td>High risk</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td>1,568</td>
<td>4,915</td>
<td>6,483</td>
</tr>
<tr>
<td>No</td>
<td>770</td>
<td>18,234</td>
<td>19,004</td>
</tr>
</tbody>
</table>

* True positive (Yes/Yes) designates cell identified by DYCAST as high risk prior to or on the date of onset of illness of earliest case located within cell. If cell was identified as high risk after date of onset of illness, or cell was never identified as high risk and a case occurred within it, it was designated false negative (Yes/No). Number of cells that contained cases is less than the number of confirmed cases (4,690) due to 50.1% of cases occurring in cells containing other cases.

†TH10 and TH05 used confirmed dengue cases (n=4,690) and a threshold of 5 and 10, respectively; TH10' used suspected dengue cases (n=9,186; both confirmed and non-confirmed cases) and a threshold of 10.

‡Denotes results from model using a threshold of 10 and all suspected dengue cases (n=9,186) instead of only confirmed cases.
One interesting finding is that D10' detected a cluster of cases in the western portion of the city at the beginning of the interepidemic period, identifying high-risk cells from July 6–August 8, 2005 (D05 also detected this cluster, but only identified risk between July 14–17) (Figure 10). What is important about this result is that this cluster was in the same location as the sole cluster of incipient risk identified in late October of that same year (Figure 11). Examination of the daily risk maps suggests that this October cluster was the initial focus of transmission for the 2006 epidemic, appearing to spill over into the surrounding areas (see Supplemental Files for an animation of D10’ risk maps during entire study period).
Figure 10. Number of confirmed dengue cases and DYCAST cells identified as high risk by models D10 (red), D05 (orange), and D10’ (yellow) per day, Ribeirão Preto, Jul 1, 2005–Jun 30, 2006. Inset x-axis has the same scale, Jul 1, 2005–Jan 1, 2006; order of models D05 and D10’ have been reversed in the inset for visualization purposes. Asterisks denote dates at which risk maps are shown in Figure 11.

Figure 11. Confirmed dengue cases and DYCAST risk maps displaying high-risk cells as identified by models D10 (red), D05 (orange), and D10’ (yellow), Ribeirão Preto. Dates correspond to asterisks in Figure 10. Maps illustrate presumed cryptic interepidemic focus of transmission (Jul 17) as well as its reemergence (Nov 1) and spread to surrounding areas (Dec 1), followed by increasing (Mar 1), peak (May 1), and contracting (Jun 30) levels of transmission, as defined by the number of high-risk cells. Cases displayed are those with an onset of illness on or up to 28 days prior to given date; this corresponds to the temporal domain of the model and thus includes all cases contributing to risk at that time. (see Supplemental Files for an animation of D10’ risk maps during entire study period).
Discussion

Summary of findings

Because there is no drug prophylaxis, human vaccine, or treatment available for DENV, mosquito control and personal protection measures are the only options available for reducing human morbidity and mortality; thus, early warning of high-risk areas would allow such efforts to be targeted in a timely and effective manner. Results from this study, which represents the first spatially explicit model that uses human cases to predict future dengue risk, indicate that the modified DYCAST model provided early and accurate identification of high risk areas in Ribeirão Preto, including detection of what appears to be the cryptic interepidemic focus of transmission that later developed into the severe 2006 epidemic. Additionally, model efficacy was retained and even enhanced by including unconfirmed dengue cases in the analysis, which has important implications for increasing the utility and applicability of the model. These findings suggests that the DYCAST system could be utilized prospectively and in real-time to identify areas at high risk of DENV transmission, in order to target mosquito control, surveillance, and public education campaigns in a timely, efficient, and cost-effective manner. Furthermore, and in a departure from previous studies, this risk model was implemented using free, open-source, and cross-platform software that could provide an inexpensive and scalable GIS solution for the surveillance and control of DENV – and potentially other infectious diseases – by Ribeirão Preto and other public health agencies in the future.
Significance of findings, assessment of applicability to current theory and practice

The DYCAST model’s average sensitivity (across all specificities) of 78.3% is given by the AUC (0.783) (42). However, this should be considered an approximation, as only three data points were used to plot the ROC; the D10’ model used different inputs than the other models as well, albeit its inclusion resulted in only a negligible increase in AUC (0.003). Youden’s J statistic, the sum of each models’ sensitivity and specificity over that of random chance, ranges from 0 (random chance) to 1.0 (perfect agreement; also -1.0 for perfect disagreement) and is useful if sensitivity and specificity are of equal importance in determining an optimal threshold (43). Model D10’ had the highest J index as well as sensitivity, and would therefore be considered the optimal model; only if specificity were of primary concern would model D10 be considered optimal.

Sensitivity values and prediction rates are interpreted to be quite high, given that the dengue models use cases to predict future cases, and as such the incipient cases will inherently reduce both measures by never being predicted (albeit this may have been partially offset by considering as predicted any cells identified as high-risk on the date of onset of its earliest case). Furthermore, both the sensitivity and prediction rate of models D10’ and D05 are greater than that of the WNV DYCAST model implemented during the unprecedented 2005 epidemic in California. This model, which used reports of dead birds to predict human cases, had a sensitivity of 80.8% (269/333 cells) and a prediction rate of 81.6% (289/354 cases) (19). However, specificity (90.6%; 66,543/73,434) was higher than that of all three dengue models.

These differences between the dengue and WNV models may reflect dissimilar viral ecologies. As a zoonotic disease, WNV transmission may be curtailed through die-
off and migration of infected and susceptible avian hosts, dynamics that do not apply to the DENV cycle. Rather, continuous presence of dense human populations, coupled with much smaller flight range and domestic proclivities of the *Ae. aegypti* vector, may account for more sustained viral transmission at a smaller scale; indeed, cells were indentified as high-risk for a much longer total mean duration by the dengue models (65.4–92.3 days) than by the WNV model (39.0 days) (19). This phenomenon may also account in part for the observation that during the study period, half of all cases (50.1%; 2,352/4,690) occurred in cells containing a prior case; 44.4% of cells (1,039/2,338) that contained at least one case contained multiple cases (mean 2.0, maximum 31). Of course, these findings may also be explained by the fact that a single mosquito can infect multiple persons within the same residence.

Regardless, this redundancy of cases within single cells accounts for the differences between prediction rates (percentage of cases predicted) and model sensitivity (percentage of cells that predicted their earliest case out of all cells that contained cases); these differences equated to 12.1%, 7.2% and 6.5% for models D10, D05, and D10’, respectively. Additionally, this redundancy allows for prediction rates to be compared against a simple null “model,” whereby cells are identified as high risk once a case occurs within them. This is equivalent to the aforementioned percentage of cases that occurred in cells containing a prior case, which provides a prediction baseline of 50.1% (2,352/4,690 cases). Models D10, D05, and D10’ were thus ≈1.6–1.8x better at predicting cases than this null model, based on an additional 1,358 (+29.0%), 1,882 (+40.1%), and 1,885 (+40.2%) cases predicted, respectively.
Results from all three models also indicated relatively high accuracy (percent agreement), as well as a moderate strength of chance-adjusted agreement (0.40<\kappa<0.60, 44); kappa can be interpreted as the percentage of correctly identified cells expected to be misidentified by chance alone. PPV and NPV are a function of the prevalence of the outcome of interest, thus the low prevalence of cells that contained a human case (9.2%; 2,338/25,487) resulted in relatively low PPV and high NPV. Because RR is not influenced by prevalence, it is a more useful (albeit proxy) measure in this circumstance for communicating model predictiveness. This measure indicates that the RR of DENV infection was \( >10x \) higher in cells identified as high-risk compared to those not identified as such.

One of the most surprising findings in this study was that running the model with both confirmed and unconfirmed cases provided earlier and greater prediction of human cases, as well as higher sensitivity and RR, than using confirmed cases alone. These additional records represented an increase of 95.9% (4,496/4,690 records) over the confirmed cases, and consisted of seemingly useless information – 96.4% (4,335/4,496) of unconfirmed cases were diagnosed as or tested negative for DENV. However, the efficacy (and superiority) of model D10’ may be explained by the following two factors. First, the model’s statistical procedure for identifying significant clustering of cases in space and time should effectively eliminate the random noise in the data, and the fact that the procedure is based on dengue-specific parameters should reduce detection of significant clustering due to non-dengue illnesses. Secondly, there may actually be an epidemiologic signal of dengue in the non-confirmed case data. This may be due to the presence of undetected dengue cases within records that were missing data (n=159) or...
due to false clinical diagnoses or laboratory findings that were negative (n=4,335) or inconclusive (n=2) for dengue. This is supported by the fact that unconfirmed cases generally follow annual trends of dengue incidence (Figure 12), however this may primarily be an artifact of greater vigilance and medical attention-seeking behavior by the population during dengue epidemics.

![Figure 12. Number of suspected cases confirmed (red) and unconfirmed (green) for dengue infection per year, 1998-2009, Ribeirão Preto.](image)

However, it is important to note that the increase in sensitivity afforded by D10' comes at a 6.5% reduction in specificity over D10. Presumably, this is due to the contribution of non-dengue cases to the detection of artificially significant clustering events. One solution would be to run multiple models at the same time (Figure 11), which would maximize both sensitivity and specificity. Alternatively, each model could be run
at different times of the year when different indices are preferred, such as running the more sensitive D10’ during the interepidemic period and running the more specific D10 during the epidemic period. Furthermore, because D05 also provides better prediction and sensitivity than D10, it may be possible that a further increase in sensitivity could be achieved by creating a hybrid of D10’ and D05 that would analyze all suspected cases at a threshold of 5.

From a practical standpoint, these results suggest that the model may retain efficacy in areas where thorough testing is not available or practical due to lack of resources or infrastructure; this has implications for making DYCAST applicable to a wider audience, as well as for the utility of modeling syndromic surveillance data. Additionally, the ability to predict high-risk areas without having to confirm suspected dengue cases eliminates the delay incurred from laboratory testing and clinical diagnoses, providing more timely results and thus a more rapid response to disease transmission.

Even without such an advantage of earlier case reporting, model D10’ predicted cases with a greater mean number of days prior to onset than did the other models. Regardless, all models predicted cases with a mean length of time prior to onset sufficient for mosquito control efforts to respond and potentially interrupt viral transmission, even accounting for the 6-day human incubation period. The models’ ability to provide early warning of disease transmission appears not to be a simple consequence of the large number of multiple cases in single cells (which increases the average duration); based only on the earliest cases within cells, the mean number of days that a cell successfully predicted its earliest case was 55.7 (std dev 38.0, median 51, max 292), 51.4 (std dev
38.5, median 46, max 295), 31.7 (std dev 31.7, median 32, max 201) for models D10’,
D05, and D10, respectively.

Another important finding is that as early as July 2005, DYCAST identified what
appears to be the primary interepidemic focus of transmission that preceded the severe
2006 epidemic. This suggests the possibility that high-risk areas identified during the
interepidemic period may reflect overwintering of the virus. Another notable feature of
this detection is that without the risk maps, the clustering of cases is not conspicuous, and
in fact appears against a backdrop of other seemingly scattered cases (Figure 11, Jul 17,
2005). This indicates that the model’s statistical approach may add value to current
surveillance and control efforts. Ultimately, such detection of otherwise cryptic
transmission foci provides an opportunity for targeted mosquito control efforts to
interrupt viral amplification before it reaches “critical mass” and spills over to
surrounding areas.

Limitations of study and findings

One limitation of the study includes potential selection bias of dengue cases, in
that addresses not included in the street reference data, such as those in the rural
periphery of the town or in newly developed areas, would not be geocoded. This may
affect the case incidence rate as well as the sensitivity of the risk model. Future work
could identify the presence of this bias through assessment of spatial structuring of
geocoding rates. Additional bias could result from a patients’ working address being
recorded instead of their residential address. While difficult to assess posteriorly, this and
similar errors could be mitigated through quality control and manual rematching of unmatched addresses by someone local and familiar with the area.

A related bias concerns one of the primary assumptions of the model, which is that illness is acquired at a person’s place of residence. While this is particularly consistent with the domestic nature of DENV transmission, illnesses acquired outside of a person’s residence may confound the results. The second assumption of the model, that DENV transmission is spatially continuous, may be violated by virtue of the fact that persons can also transmit the virus to mosquitoes outside of their place of residence as well. Provided sufficient rates of vertical transmission, this assumption may also be violated by accidental human transport of *Ae. aegypti* eggs and larvae, which is reported in Brazil to be more important than adult flight for dispersion of the vector (29). Nevertheless, given the spatially confined flight range of the adult form that actually transmits the virus, violations of this assumption are considered to be negligible.

The third assumption of the model is that non-random spatiotemporal clustering indicates amplification of DENV. While this is assumption is fully met by using only confirmed dengue cases, it may be violated by including non-dengue cases, as likely illustrated by the 5.9% reduction in specificity of D10’ compared to that of D10. However, as mentioned above, the model’s dengue-specific statistical procedure should generally limit the influence of such violations. Fourth, it is assumed that each dengue case has an equal opportunity of being reported. Differential rates of symptomatic DENV illness among various immunologic, age, or demographic groups may violate this assumption if such populations exhibit sufficient spatial heterogeneity (e.g., distribution of DENV antibodies within the population following spatially-structured epidemics).
This and the fact that DENV is asymptomatic in the majority of infections (45) may also yield false positive identifications, thereby reducing validity measures such as specificity and PPV. Unfortunately, these and other reporting biases are difficult to rigorously assess in the absence of serologic surveillance information. Symptomatological considerations aside, however, the existence of free universal healthcare in Brazil and prevalent media campaigns informing citizens about DENV symptoms may ensure that this assumption is generally met.

Other limitations concern the implementation of the software itself. The tradeoff with using multiple open source software components is that compatibility issues may arise as new versions of the various components are released. This was found to be the case in this study, and prompted the creation of protocols and a troubleshooting section to facilitate future implementations of the model (see Appendix). Additionally, running the model is computationally expensive, and required between 30 seconds to 2.5 hours to complete risk analysis for a single day. Thus, a dedicated computer with powerful hardware is recommended.

**Relevant recommendations**

Future work will include running the dengue risk model(s) for additional years, to assess whether findings are similar during more (i.e., 2010) or less severe epidemics. One important avenue for future research includes the biology of *Ae. aegypti* from Ribeirão Preto populations, as findings from previous studies are often inconsistent and/or location-specific. Three main research objectives for informing the DYCAST model parameters are recommended. First, mark-release-recapture (MRR) studies in Ribeirão
Preto could determine the mean and maximum dispersion of the vector, which would elucidate the optimal spatial domain and spatial closeness parameters for this study area. Second, research should examine the role of temperature in affecting the lengths of the EIP and gonotrophic cycle of *Ae. aegypti*, which would inform the temporal domain and temporal closeness parameters. Such findings could be incorporated by specifying different parameters throughout the year, such as longer temporal parameters for a winter (interepidemic) model and shorter durations for a summer (epidemic) model, or by adjusting the relevant parameters based on real-time temperature data.

Additionally, population census data could be sampled at each grid cell’s centroid at a radius equal to the model’s 600 m spatial domain, in order to generate Monte Carlo distributions that reflect the spatial heterogeneities of the underlying human population (46). A more sophisticated approach, dasymetric mapping (47), could be used to re-aggregate population counts to only populated regions within a given census tract, as defined by remote sensing-derived land use classification imagery and/or residential lots data. This would yield a more accurate population layer by reducing error from the ecological fallacy of choropleth mapping.

Recommendations for future program development include the establishment of a pilot program to create an open source GIS network for electronic mapping and sharing of otherwise fragmented datasets used for surveillance and control by the various local health departments, vector control agency, and municipal government (CODERP) in Ribeirão Preto. This would provide for routine and timely mapping of surveillance data, and would allow for more rapid, coordinated, and efficient management across all facets of disease control, from public education campaigns and clinical surveillance to
prospective modeling and targeted vector control. This integrated framework would also better facilitate the practical application of the current research findings and act as a catalyst for further in-depth research.

This program would also serve as a replicable template for deploying scalable, no-cost GIS solutions that can be adopted by resource-limited areas around the world for the surveillance and control of dengue and other infectious diseases. Rather than relying on expensive commercial software packages, this project could leverage the free and open source software solutions used in the present study, thus providing a cheap but powerful GIS network with potential for web and mobile deployment. Future surveillance data could be collected by local agencies and entered in electronic format via PostgreSQL clients or online interfaces, created by using the Python Web Processing Service (PyWPS), for access remotely or via mobile devices; dynamic web content, such as case and risk maps used for public education campaigns, could be published by using Hypertext Preprocessor (PHP) scripting language. Security could be maintained by using Secure Sockets Layer (SSL) protocol to encrypt client/server communications, as well as password protection of computer accounts. Case data entered from the backend could be automatically geocoded and mapped; support for Geospatial Data Abstraction Library (GDAL) via the GDAL-GRASS plug-in would enable integration with other software as needed. Quantum GIS (QGIS; www.qgis.org) could be implemented for a more user-friendly frontend that includes a GUI in Portuguese, or GRASS GIS, which supports various visualizations (2D, 2.5D, and 3D raster and vector data) and spatial analyses. The latter could include R (www.r-project.org), coupled with the crimestats, spatstat, and splancs packages for additional spatial and spatiotemporal analyses.
Regardless of these additional features, installation on a single computer of the components used in this study would allow for the prospective implementation of the dengue DYCAST model, which could generate daily risk maps in real-time for the immediate use in surveillance and control efforts. Protocols are also provided herein for installing the various software components, modifying the Python scripts to model dengue risk, and generating the necessary spatial datasets (see Appendix). The open source version of the DYCAST software and documentation (see Acknowledgments) can be downloaded at [www.dycast.org](http://www.dycast.org), a web domain purchased by the present study’s author to facilitate the dissemination of the model and results to a global audience, and which will be fully developed in the future. Ultimately, the practical application of these modeling efforts via a GIS pilot program may act as a catalyst for further research and open source collaboration, and enhance public health infrastructure of the developing world that bears the greatest burden of dengue morbidity and mortality.
H. References


http://apps.who.int/tdr/svc/publications/tdr-research-publications/swg-report-dengue


Appendix I. Protocol – software installation, modification, FAQ

Installation (Windows):

1. **PostgreSQL**
   - [http://www.postgresql.org/download/windows](http://www.postgresql.org/download/windows)
   - install **PostgreSQL 8.4.3-1** (one-click installer, not the pgInstaller)

2. **PostGIS**
   - install **PostGIS v 1.5.1** using the PostgreSQL installer’s Stack Builder, since it offers the latest version - no need to install separately afterwards. (latest version: [http://postgis.refractions.net/download/windows/](http://postgis.refractions.net/download/windows/))
   - enable the **shp2pgsql** graphical loader plugin (will use later for grid creation)

3. **Python**
   - [http://www.python.org/download/releases/2.6.5/](http://www.python.org/download/releases/2.6.5/)
   - module psycopg2 (below) requires Python 2.6.x and earlier [see Troubleshooting below for conflict with ArcView]
   - install Windows **64-bit version** of Python **2.6.5**
   - restart computer

4. **Psycopg2**
   - if applicable, install the **64-bit version** of **psycopg 2.0.14** “(For Python 2.6 amd64)(64bit Windows)”; be sure to use the specific build of psycopg2 for your specific version of Python.
   - restart computer

* "The binaries for AMD64 will also work on processors that implement the Intel 64 architecture (formerly EM64T), i.e. the architecture that Microsoft calls x64, and AMD called x86-64 before calling it AMD64. They will not work on Intel Itanium Processors (formerly IA-64). "
5. **DYCAST**

- From [www.dycast.org](http://www.dycast.org), download and unzip **application.zip**. In the application folder:
  
  - delete the psycopg2 folder in DYCAST/application/lib
  
  - Open **dycast.config** file in WordPad or Notepad and make the following changes:

    1. under [database]:

        change password from: **postgres**
        to: [ insert PostgreSQL password ]

    2. under [dycast]:

        - spatial domain: **0.372822** [600 meters]
        - close_in_space: **0.062137** [100 meters]
        - close_in_time: **4**
        - temporal_domain: **28**
        - bird_threshold: **10** [analysis threshold]

        [Note: need to close and restart ui.py every time you change parameters]

    3. under [other]:

        - spatial_reference_unprojected: **29193**
        - spatial_reference_projected: **29193**

    - Save and close

3. Right-click **postgres_init.sql** (also in application folder) > Edit (opens in Notepad)

    - do Find-Replace All to change all instances of 4269 and 54003 to **29193**
    - This is the EPSM code relevant for Ribeirão Preto. Save and close

4. Right-click **dycast.py** > Edit with IDLE

    - line 200: change: 4269 and 54003 to: **29193**
• line 493 [“def get_county_id(tile_id):” statement]:

change this: 
return cur.fetchone()[0]
to this: 
return 1

• Save and close

5. Right-click setup_db.bat > Edit

• PostgreSQL 8.4 installs into a different directory than 8.2, and also has a different share path. Therefore, change lines 12 and 13 to:

```bash
set PG_BIN_PATH=C:\Program Files (x86)\PostgreSQL\8.4\bin\nset PG_SHARE_PATH=C:\Program Files
(x86)\PostgreSQL\8.4\share\contrib\postgis-1.5\n```

• Another change in 8.4 is that the file lwpostgis.sql is renamed to postgis.sql. Therefore, change line 24 to:

```bash
%PG_BIN_PATH%\psql.exe" -U %USERNAME% -d
%DBNAME% -f "%PG_SHARE_PATH%postgis.sql
```

• Save and close

Installation (MacOS X):

1. **PostgreSQL 8.4.3-1** [http://www.enterprisedb.com/products/pgdownload.do#osx](http://www.enterprisedb.com/products/pgdownload.do#osx)
   - Note: installer will automatically change shared memory settings, which may destabilize system (see Troubleshooting, below). Additionally, instructions for manually doing this are included in the Readme.

2. **PostGIS**
   - the Stack Builder app that PostgreSQL runs offers PostGIS 1.4. The newest version ([http://postgis.refractions.net/download/](http://postgis.refractions.net/download/)) is **1.5.0-1**, but this won’t install (keeps saying Postgres 8.4 must be installed, which it is); this may have something to do with the location requirement [from ReadMe]: “Postgres must be installed in the default location (/usr/local/pgsql), as is my Postgres package.”
   - Therefore, use PostgreSQL’s Stack Builder to install PostGIS version 1.4.

3. **Python:**
   - comes pre-installed on Mac OS X: Terminal > python:
     I have: **Python 2.6.1** (r261:67515, Jul 7 2009, 23:51:51)

   - download psycopg2 2.0.14
   - in **setup.cfg** file, change line 31:

     ```
     from #pg_config=
     to: pg_config=Library/PostgreSQL/8.4/bin/pg_config
     ```

5. **DYCAST**
   - put folder in: **Users/Ryan/Documents**
   - follow **Steps 5.1 – 5.4** listed above (Windows installation) for modifying scripts.
• Also, modify **dycast.config** (open in TextEdit)

  **[system]**
  change:  unix_dycast_path: /Users/alan/Documents/DYCAST/
to:  unix_dycast_path: /Users/Ryan/Documents/DYCAST/

  **[database]**
  change:  password: postgres
to:  password: _______

• modify **setup_db.sh** (open in TextEdit)

  **line 6**
  change:  DYCAST_PATH=/Users/alan/Documents/DYCAST/
to:  DYCAST_PATH=/Users/Ryan/Documents/DYCAST/

  **line 9**
  change:  #PG_BIN_PATH=/usr/local/pgsql/bin...?
to:  PG_BIN_PATH=/Library/PostgreSQL/8.4/bin/

  **line 10**
  change:  PG_SHARE_PATH=/usr/local/pgsql/share/
to:  PG_SHARE_PATH=/Library/PostgreSQL/8.4/share/postgresql/contrib

  **line 15**
  change:  psql -U $USERNAME -d $DBNAME -f
                   $PG_SHARE_PATH/lwpostgis.sql
to:  $PG_BIN_PATH/psql -U $USERNAME -d $DBNAME –f
                   $PG_SHARE_PATH/postgis.sql

• lines 12-22:  "SPG_BIN_PATH" needs to be inserted before each command
  (dropdb, createdb, createlang, etc.).

• open with (or copy-paste script into) **Terminal** to run setup

• Double-click **setup_db** to initialize database. Will prompt for password multiple times.
Troubleshooting FAQ

1. Problem: [Windows]: DYCAST (file ui.py) no longer runs after installing ArcView 9.3.0:

![Screen capture of ArcGIS Setup]

Cause: ArcView installed an older version of Python (2.5.1, see below), which conflicts with the Python 2.6 already installed (psycopg2 looks for python in the Python25 folder – see above screenshot).
Solution: The only way to get around this incompatibility issue is to drag the ui.py file onto the copy of python in the \C:/Python26\ folder. Otherwise, simply double-clicking on the file will have it try to run off the Python25 copy, which won’t work.

Background Information:

The full list of operations requiring Python/Numpy include (taken from “Python_requirement.htm” file on installation DVD):

Analysis Tools
- Proximity Toolset
- Multiple Ring Buffer

Conversion Tools
To dBASE
- Table to dBASE (multiple)

To Geodatabase
- Feature Class to Geodatabase (multiple)
- Table to Geodatabase (multiple)

To Shapefile
- Feature Class to Shapefile (multiple)

Spatial Statistics
Analyzing Patterns
- Average Nearest Neighbor
- High/Low Clustering (Getis-Ord General G)
- Spatial Autocorrelation (Morans I)

Mapping Cluster
- Cluster and Outlier Analysis (Anselin Local Morans I)
- Hot Spot Analysis (Getis-Ord Gi*)

Measuring Geographic Distributions
- Central Feature
- Directional Distribution (Standard Deviation Ellipse)
- Linear Directional Mean
- Mean Center
- Standard Distance

Utilities
- Calculate Areas
- Collect Events
- Count Rendering
- Export Feature Attribute to Ascii
- Z Score Rendering
2. **Problem:** [Mac OS]: Computer destabilizes after PostgreSQL installation, causing crashing, slowdown, and startup displaying blinking folder icon with “?” sign.

**Cause:** Conflicts due to reconfiguration of Shared Memory settings by PostgreSQL installer.

**Background Information:**

PostgreSQL One Click Installer README
=====================================  
Shared Memory
------------
PostgreSQL uses shared memory extensively for caching and inter-process communication. Unfortunately, the default configuration of Mac OS X does not allow suitable amounts of shared memory to be created to run the database server.

Before running the installation, please ensure that your system is configured to allow the use of larger amounts of shared memory. Note that this does not 'reserve' any memory so it is safe to configure much higher values than you might initially need. You can do this by editing the file /etc/sysctl.conf - e.g.

`% sudo vi /etc/sysctl.conf`

On a MacBook Pro with 2GB of RAM, the author's sysctl.conf contains:

```text
kern.sysv.shmmax=1610612736  
kern.sysv.shmall=393216  
kern.sysv.shmmin=1  
kern.sysv.shmmni=32  
kern.sysv.shmseg=8  
kern.maxprocperuid=512  
kern.maxproc=2048
```

Note that (kern.sysv.shmall * 4096) should be greater than or equal to kern.sysv.shmmax.

kern.sysv.shmmax must also be a multiple of 4096.

Once you have edited (or created) the file, reboot before continuing with the installation. If you wish to check the settings currently being used by the kernel, you can use the sysctl utility:

`% sysctl -a`

The database server can now be installed. For more information on PostgreSQL's use of shared memory, please see: [http://www.postgresql.org/docs/current/static/kernel-resources.html - SYSVIPC](http://www.postgresql.org/docs/current/static/kernel-resources.html - SYSVIPC)

Support. For help with this installer, please visit the forum at: [http://forums.enterprisedb.com/forums/show/9.page](http://forums.enterprisedb.com/forums/show/9.page)
When you run PostgreSQL installer, you receive this message:

![Image of warning message]

…which modifies the following:

- **my settings before (Terminal > sysctl -a):**

  ```
  kern.sysv.shmmax: 4194304
  kern.sysv.shmmin: 1
  kern.sysv.shmmni: 32
  kern.sysv.shmseg: 8
  kern.sysv.shmall: 1024
  kern.sysv.semmni: 87381
  kern.sysv.semmns: 87381
  kern.sysv.semmnu: 87381
  kern.sysv.semmsl: 87381
  kern.sysv.semume: 10
  ```

- **my settings after PostgreSQL installation:**

  ```
  kern.sysv.shmmax: 33554432
  kern.sysv.shmmin: 1
  kern.sysv.shmmni: 256
  kern.sysv.shmseg: 64
  kern.sysv.shmall: 8192
  kern.sysv.semmni: 87381
  kern.sysv.semmns: 87381
  kern.sysv.semmnu: 87381
  kern.sysv.semmsl: 87381
  kern.sysv.semume: 10
  ```
**Solution:** Running the uninstaller in Library/PostgreSQL will NOT automatically revert sysctl.conf settings, therefore you must do this manually:

1. Shut down computer
2. Restart and press **Command-S** while booting. This boots in single user mode.
3. At the prompt (“:/ root#”) type the following four commands in sequence:
   
   ```
   /sbin/fsck -fy
   /sbin/mount -uw /
   rm /etc/sysctl.conf
   exit
   ```

   [resulting procedure will take a moment]
   [this mounts in read/write mode]

   Note that the last three commands will not provide any response, just reprompt you.
4. Restart computer.
5. Run **Terminal**, and type:

   ```
   sysctl -a
   ```

   Verify that kern.sysv settings have reverted to previous.
Appendix II. Protocol – geocoding

1. CREATE ARCMAP DOCUMENT

1. Open ArcMap and begin a new map document.

2. Add aerial photograph (OPTIONAL) [Note: this was taken 2005]

   - [update 2010-04-01] According to Wilson: “On the spatial reference of the photograph, all were designed using North American Datum 1969 UTM Zone 23S.” However, there is no NAD 1969, only NAD 1927 and NAD 1983, and they only have UTM Zones with “N”, not “S”. Perhaps he meant SAD 1969?

   - Open ArcCatalog and navigate to Foto.TIF > right-click > Properties > Spatial Reference [which should read “<Undefined>”] > Edit > Select > Projected Coordinate Systems > UTM > South America > South American 1969 UTM Zone 23S.prj * > Add > OK:

   ![Spatial Reference Properties](image)

   Since there is no original projection file accompanying this raster file, the particular Spatial Reference (SAD_1969_UTM_Zone_23S) was determined from the following three pieces of evidence:

   A. Foto.tab file (within the CODERP DVD folder) states:

   ```
   !table
   !version 300
   !charset WindowsLatin1
   
   Definition Table
   File "300.TIF"
   Type "RASTER"
   (197457.283284349,7666274.3256114) (0,0) Label "Pt1",
   ```
This CoordSys Earth Projection means it is in some kind of UTM.

B. CODERP DVD geodesic data use several UTMs:  [see Monografias files]

Projection: Internacional 1967      WGS-84
Datum:        SAD-69              WGS-84
              Internacional 1924 - Hayford
              Córrego Alegre

C. …IBGE map of Ribeirão Preto however, only uses:  [SP-RibeiraoPreto.pdf]

Projection:  UTM *
Datum (horizontal):  SAD 69

* “origem da quilometragem UTM: Equador e Meridiano 45 W Gr. Acrescidas
as constantes de 10.000 e 500 Km respectivamente”  →  “origin mileage UTM
Ecuador and Meridian 45 W Gr Plus the constants of 10,000 and 500 km
respectively.” The boldface denotes it is UTM 23S:
http://home.pacbell.net/lgalvin/UTMWGS84CoordSys.html

D. Therefore, I tested both spatial references for Foto.TIF [against
RIBEIRAO_PRETO_SP with GCS_South_American_1969 /
D_South_American_1969 (unprojected)]:

• SAD_1969_UTM_Zone_23S:  [correct]
Add **Foto.TIF** from CODERP DVD > single-click Foto.TIF to select (to retain all 3 bands) > Add. When prompted, clicked Yes to **build pyramids**.

3. **Add streetlayer**

Unzip **Arruamento.zip** file (Note: it contains the projection file). Add newly unzipped **RIBEIRAO_PRETO_SP.shp** from the Arruamento folder. Its spatial reference is the following*:

- **GCS:** GCS_South_American_1969
- **Datum:** D_South_American_1969
- **Prime Meridian:** Greenwich
- **Angular Unit:** Degree

* Note: no mismatches exist between **RIBEIRAO_PRETO_SP.shp** and **Foto.TIF** layers when the Layers’ data frame is either unprojected (a la former file’s GCS) or projected (latter’s **SAD_1969_UTM_Zone_23S**). However, the former’s map units are in **Decimal Degrees**, which is why I used the latter (in **meters**) – this also provides perpendicular lat-long rasters/grids!

4. **Project streetlayer**
ArcToolbox > Data Management Tools > Projections and Transformations > Feature > Project

Input Dataset or Feature Class: RIBEIRAO_PRETO_SP.shp
Input Coordinate System (optional): [GCS_South_American_1969 should be displayed]
Output Dataset or Feature Class: DATA\STREETS\ADDRESS_LOCATOR\03_2010_LOCATOR\Arruamento\streets_P_SAD69_UTM23S.shp
Output Coordinate System: click button to right > Select > Projected Coordinate Systems > UTM > South America > South American 1969 UTM Zone 23S.prj > Add > OK

[will appear as SAD_1969_UTM_ZONE_23S]

Geographic Transformation (optional): [null – none is needed] > OK

5. Resulting new shapefile should perfectly overlay the old, unprojected version. Remove the old one.
II. OFFSET DETERMINATION

1. Create raster of distance from street values

   • Spatial Analyst toolbar > Distance > **Straight Line**:

     Distance to:          streets_P_SAD69_UTM23S
     Maximum distance:  [null]
     Output cell size:    1  [units in meters]
     Create direction:   [leave box unchecked]
     Create allocation:  [leave box unchecked]
     Output raster:      street_P_dist

     [right-click > Symbology tab > Classified > Classify button to manually re-classify symbology]

2. Add CODERP cases  [n=11,909]

   • Add Data > DATA\HUMANS\SHAPEFILES\I_CODERP_2007-2008\I.ORIGINAL_SAD69_UTM23S\2008-06-11_Dengue_2007-2008_cases_SAD69_UTM23S.shp

     Ignore the following error message: “The following data sources you added are missing spatial reference information. This data can be drawn in ArcMap, but cannot be projected.”

     [Note: spatial reference for shapefile cannot be added using ArcCatalog]

   • **ArcToolbox** > Data Management Tools > Projections and Transformations > Define Projection

     Input Dataset or Feature Class       2008-06-11_Dengue_2007-2008_cases_SAD69_UTM23S
     Coordinate System       South American 1969 UTM Zone 23S.prj *

     [Note: I subsequently projected the file as SAD69 as well to create the .PRJ file]

   * Note: I tested out two other UTM23S projections – **WGS84 (blue)** and **Corrego Alegre (yellow)** – and when I did an error stated, “Datum conflict between map and output.” **Red = SAD69**, which is also where the WGS and CA points were before defining their respective projections. Also reprojected WGS84 as SAD69 (not shown) but the result was even further off:
• Results: distance between SAD69 and WGS84 points $\approx 8.2$ meters

• SAD69 appeared to have the better results (see above, inset)

• Additionally, I did same test for CODERP’s vector area and health jurisdiction shapefiles (both without .PRJ and spatial reference information), and both were unequivocally SAD_1969_UTM_Zone_23S as well.

3. Extract distance values at location of CODERP cases

• ArcToolbox > Spatial Analyst Tools > Extraction > Extract Values to Points

  Input point features 2008-06-11_Dengue_2007-2008_cases_SAD69_UTM23S
  Input raster streets_P_dist
  Output point features 2008-06-11_Dengue_2007-2008_cases_SAD69_UTM23S_dist_from_street.shp
  Interpolate values… [unchecked]
Append all the input…   [unchecked]

- RESULTS:

<table>
<thead>
<tr>
<th></th>
<th>ALL</th>
<th>&lt;100 m*</th>
<th>CLASSI 1-4**</th>
<th>CLASSI 1-4 (&lt;100 m*)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>11,909</td>
<td>11,409</td>
<td>3,486</td>
<td>3,396</td>
</tr>
<tr>
<td>Minimum</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Maximum</td>
<td>857.829834</td>
<td>99.985001</td>
<td>718.936035</td>
<td>99.985001</td>
</tr>
<tr>
<td>Sum</td>
<td>405020.05598</td>
<td>232655.718402</td>
<td>100817.241362</td>
<td>68557.512587</td>
</tr>
<tr>
<td>Mean</td>
<td>34.009577</td>
<td>20.392297</td>
<td>28.920609</td>
<td>20.187725</td>
</tr>
<tr>
<td>Stand Dev</td>
<td>76.834624</td>
<td>11.022413</td>
<td>62.400914</td>
<td>10.166674</td>
</tr>
<tr>
<td>Median</td>
<td>18.867962</td>
<td>18.439089</td>
<td>18.788294</td>
<td>18.439089</td>
</tr>
</tbody>
</table>

* to exclude points on roads not represented on street layer (thus >100 m). Frequency Distribution →

** 3,486 confirmed dengue cases – those with “CLASSI_FIN” values of 1 (n=3,466), 2 (n=15), 3 (n=5), and 4 (n=0)

- FINAL VALUE FOR ADDRESS LOCATOR:

```
median of <100 m : 18.44 meters = 60.50 feet
(falls between standard offsets): 50 feet = 15.24 m
                               100 feet = 30.48 m
```

![Frequency Distribution](image-url)
III. ADDRESS LOCATOR

1. Copy Brazilian Geocode and Locator files to system
   • in Windows Vista, I went to Program Files (x86) > ArcGIS and copied folder Geocode and Locators, and added “_ORIGINAL” suffix to both copies.
   • I then copied the files from 02_from ROBOTRON_2010-03-28 > C_ProgramFiles_ArcGIS > Geocode and Locator folders into the Program Files (x86) > ArcGIS folders of the same name, and skipped replacing all the files already present (effectively retaining original, US files and adding only the Brazilian ones).
   • reformatted human data: “Dengue_1998-2010_11_reformatted for geocoding.xlsx” (see HUMANS notes for details).

2. Create CEP Address Locator
   • ArcCatalog > right-click destination folder > New > Address Locator > Choose an Address Locator Style: Endereço BR com CEP (File) > OK

Name: 01_Endereco BR com CEP File-based
Description: [keep default: Estilo brasileiro com CEP (File-based)]
Reference data:
...DATA\STREETS\ADDRESS_LOCATOR\03_2010_LOCATOR\Arruamento\streets_P_SAD69_UTM23S.shp
Store relative path names [check box]

Fields
Tipo do logradouro: TIPO
Nome do logradouro: NOME
Numeração inicial esq: NUM_IE
Numeração final esq: NUM_FE
Numeração inicial dir.: NUM_ID
Numeração final dir.: NUM_FD
CEP esq.: CEP_LE
CEP dir.: CEP_LD

Input Address Fields The field containing: is recognized if it is named:
[delete defaults, add following:] Street ADDRESS_concatenated Zone NU_CEP

Matching Options
Spelling sensitivity: 80 [default]
Minimum candidate score: 10 [default]
Minimum match score: 60 [default]
Output Options

- Side offset: 18.44 in Meters [result from offset analysis]
- End offset: 3 [default]
- Match if candidates tie: [keep box checked]

Output Fields: [check all four boxes]

3. Create BAIRRO Address Locator:

- **ArcCatalog** > right-click destination folder > New > **Address Locator** > Choose an Address Locator Style: **Endereço BR com CEP (File)** > OK

Name: **02_Endereco BR com CEP File-based**
Description: [keep default: **Estilo brasileiro com CEP (File-based)**]
Reference data:

```
...DATA\STREETS\ADDRESS_LOCATOR\03_2010_LOCATOR\Arruamento\streets_P_SAD69_UTM23S.shp
```

Store relative path names [check box]

**Fields**

- Tipo do logradouro: **TIPO**
- Nome do logradouro: **NOME**
- Numeração inicial esq: **NUM_IE**
Input Address Fields
- The field containing:
  - Street
  - Zone

is recognized if it is named:
- ADDRESS_concatenated
- BAIRRO

Matching Options
- Spelling sensitivity: 80 [default]
- Minimum candidate score: 10 [default]
- Minimum match score: 60 [default]

Output Options
- Side offset: 18.44 in Meters [result from offset analysis]
- End offset: 3 [default]
- Match if candidates tie: [keep box checked]

Output Fields: [check all four boxes]

4. Create COMPOSITE Address Locator

- ArcCatalog > right-click destination folder > New > Address Locator > Choose an Address Locator Style: Composite > OK

Name: 03_COMPOSITE_01_and_02

Participating Address Locators:
- [click Browse button to right and select: 01_Endereco BR com CEP File-based and then 02_Endereco BR com BAIRRO File-based]

Input Address Fields:
- The field containing:
  - Endereco
  - CEP
  - BAIRRO

is recognized if it is named:
- ADDRESS_concatenated
- NU_CEP
- BAIRRO

Click to select 01_Endereco BR com CEP File-based in Participating Address Locators:

Input mappings:
- Endereco: Endereco
- CEP: NU_CEP

Click to select 02_Endereco BR com BAIRRO File-based in Participating Address Locators:

Input mappings:
- Endereco: Endereco
- CEP: BAIRRO

Output fields: [check all four boxes]
3. **Geocode cases**

- **ArcMap** > Add Data > *Dengue_1998-2010_12_bairro.csv*
- Table of Contents’ Source tab > Right-click .csv file > Geocode Address > Add > *03_COMPOSITE_01_and_02* > OK
- Address Input Fields:  ADDRESS_concatenated:
  - ADDRESS_concatenated: 
  - NU_CEP: 
  - BAIRRO: 
- Output shapefile or feature class:
  - *03_Dengue_1998-2010_12_Loc_03_COMPOSITE_80-10-60.shp*
# / Locator | Data | Parameters* | Matched | Tied | Unmatched
---|---|---|---|---|---
01. 01_Endereco com CEP | 18 | 80-10-60 | 30,006 (56%) | 589 (1%) | 22,661 (43%) | 57%
02. 02_Endereco com BAIRRO | 18 | 80-10-60 | 7,488 (14%) | 124 (0%) | 45,644 (86%) | 14%
03. 03_Composite (01 + 02) | 18 | 80-10-60 | 30,503 (57%) | 598 (1%) | 22,155 (42%) | 58%
04. 03_Composite (01 + 02) | 18 | 40-10-30 | 35,866 (67%) | 777 (1%) | 16,613 (31%) | 68%
05. 03_Composite (01 + 02) | 18 | 40-10-15 | 39,420 (74%) | 1,573 (3%) | 12,621 (24%) | 74%
06. 03_Composite (01 + 02) | 18 | 50-10-23* | 40,352 (76%) | 6,490 (12%) | 6,414 (12%) | 88%
07. 03_Composite (01 + 02) | 18 | 0-0-0 | 39,420 (74%) | 1,573 (3%) | 12,621 (24%) | 74%
08. 03_Composite (01 + 02) | 18 | 0-0-0 | 39,420 (74%) | 1,573 (3%) | 12,621 (24%) | 74%
09. 03_Composite (01 + 02) | 18 | 0-0-0 | 39,420 (74%) | 1,573 (3%) | 12,621 (24%) | 74%
10. 03_Composite (01 + 02) | 18 | 0-0-0 | 39,420 (74%) | 1,573 (3%) | 12,621 (24%) | 74%
11. 03_Composite (01 + 02) | 18 | 0-0-0 | 39,420 (74%) | 1,573 (3%) | 12,621 (24%) | 74%
12. 03_Composite (01 + 02) | 18 | 5-5-5 | 39,800 (75%) | 3,551 (7%) | 9,905 (19%) | 82%
13. 03_Composite (01 + 02) | 18 | 5-5-5 | 39,800 (75%) | 3,551 (7%) | 9,905 (19%) | 82%
14. 03_Composite (01 + 02) | 18 | 50-10-23* | 37,544 (70%) | 940 (2%) | 14,772 (28%) | 72%
15. 03_Composite (01 + 02) | 18 | 40-10-23* | 37,544 (70%) | 940 (2%) | 14,772 (28%) | 72%
16. 03_Composite (01 + 02) | 18 | 50-10-23 | 38,485 (72%) | 1,071 (2%) | 13,700 (26%) | 74%
17. 03_Composite (01 + 02) | 18 | 0-0-0 | 40,352 (76%) | 6,490 (12%) | 6,414 (12%) | 88%
18. 03_Composite (01 + 02) | 18 | 5-5-5 | 39,893 (75%) | 4,618 (9%) | 8,745 (16%) | 84%
19. 03_Composite (01 + 02) | 18 | 5-5-5 | 39,893 (75%) | 4,618 (9%) | 8,745 (16%) | 84%
20. 03_Composite (01 + 02) | 18 | 5-5-5 | 39,893 (75%) | 4,618 (9%) | 8,745 (16%) | 84%
21. 03_Composite (01 + 02) | 18 | 5-5-5 | 39,893 (75%) | 4,618 (9%) | 8,745 (16%) | 84%
22. 03_Composite (01 + 02) | 18 | 5-5-5 | 39,893 (75%) | 4,618 (9%) | 8,745 (16%) | 84%
23. 03_Composite (01 + 02) | 18 | 5-5-5 | 39,893 (75%) | 4,618 (9%) | 8,745 (16%) | 84%

* Parameters: Spelling sensitivity – Minimum candidate score – Minimum match score

2. **MMS Distribution analysis:** for 0-0-0, distribution of scores (compare vis-à-vis Minimum Match Score). Used 0-0-0 because for Unmatched, all records < Minimum Match Score are set to zero, apparently)
* second group of peaks is at Score = 24 (n=2,519), another at 28. So, set MMS at 23.

- If I remember correctly, the minimum match score for the WNV dead bird data (circa 2005, 2006) was also 30

3. **Analysis of Tied’s:**
   - 20-10-23: the “Matches” around 28 and lower were not matches! don’t use!
   - 40-10-23: were better, but still off.
   - **60-10-23:** all were matches, very good!
   - 50-10-23: mostly matches, a few incorrect however.

4. **Manual rematching**
   - Address numbers within 100 were cool. All of potential matches were within 100 though.
   - Rematched half (n=7,500) of Unmatched (n=14,772). Matched 252 (1% of total).
   - Found that all candidate addresses with score of 10 or higher (may not have actually been any <10) were Matched, therefore Step 5:

5. **Automatic rematching**
   - Geocoding Options button (bottom left) > set both address locators in COMPOSITE to **60-10-10**
This matched an additional 252 (246 Matched, 6 Tied), bringing the final total to:

<table>
<thead>
<tr>
<th>Matched</th>
<th>Tied</th>
<th>Unmatched</th>
<th>M+T</th>
</tr>
</thead>
<tbody>
<tr>
<td>38,042 (71.4%)</td>
<td>946 (1.8%)</td>
<td>14,268 (26.8%)</td>
<td>38,988 (73.2%)</td>
</tr>
</tbody>
</table>

recommend using 60-10-10 in the future

from 19

| total geocoded: | 38,988 | 06a_FINAL_HUMANS...n_38988.xls |
| total geocoded 1-4: | 13,546 | 06b_FINAL_HUMANS...n_13546.xls |
Appendix III. Protocol – grid creation

1. Create new polygon shapefile in ArcCatalog
   - Open ArcCatalog > File > New > Shapefile:
     - Name: DYCAST_RP_polygon
     - Feature Type: Polygon
     - Spatial Reference > Edit: SAD_1969_UTM_Zone_23S *
       [leave M and Z values boxes unchecked] > OK

2. Edit polygon in ArcMap
   - ArcMap > Add Data > navigate to and add new shapefile
   - Editor toolbar > Start Editing > select parent folder for new shapefile
   - Click the editing tools drop-down menu and select the pencil icon.
   - right-click on the map > select Absolute X,Y > copy-paste these two values (which correspond to the NW corner of aerial photo*) > Enter:
     
     197457.283284349  7666274.3256114

   - Repeat the previous step for the next three corners:
     
     197457.283284349  7639474.3256114
     224257.283284349  7639474.3256114
     224257.283284349  7666274.3256114

   - right-click map > Finish Sketch
   - Editor toolbar > Save Edits > Editor toolbar > Stop Editing

* Foto.TIF: Columns and Rows: 24991, 24991
      Cellsize (X,Y): 1.0715412, 1.0715412
      Top: 7666274.3256114
      Left: 197457.283284349
3. Convert to raster

- **Spatial Analyst** toolbar > Convert > **Features to Raster**
  
  Input features: DYCAST_RP_polygon
  Field: Id
  Output cell size: 100
  Output raster: DYCAST_RP_ras

4. Sample raster (add X,Y coordinates)

- **ArcToolbox** > Spatial Analyst Tools > Extraction > **Sample**
  
  Input rasters: DYCAST_RP_ras
  Input location raster or point features: DYCAST_RP_ras
  Output table: DYCAST_RP_centroids
  Resampling technique (optional): [keep as NEAREST]

5. Display centroids

- Add Data > **DYCAST_RP_centroids**
- Table of Contents > Source tab > right-click new table > **Display XY Data**
  
  X Field: X
  Y Field: Y
  Coordinate System of Input Coordinates > Edit > Select > **South American 1969 UTM Zone 23S.prj**
  
  Display tab > right-click new shapefile > Open Attribute Table > right-click “DYCAST_RP_RAS” > **Delete Field**. Repeat for column, “DYCAST_RP_RAS_1” and close out window.
  
  right-click shapefile > Data > Export Data > effects_poly_centers_projected.shp
• click Yes to add exported data to the map as a layer.

6. Convert centroids to raster

• ArcToolbox > Conversion Tools > To Raster > Point to Raster

Input Features: effects_poly_centers_projected
Value field: FID
Output Raster Dataset: effects_rast
Cell assignment type: [keep default, MOST FREQUENT]
Priority field (optional): [keep default, NONE]
Cellsize: 100

7. Convert raster to shapefile

• Spatial Analyst toolbar > Convert > Raster to Features

Input raster: effects_ras
Field: VALUE
Output geometry type: Polygon
Generalize lines: [keep box checked]
Output features: DYCAST_RP_cells_n_71824.shp

8. Add grid to PostgreSQL

• pgAdmin III: in Object Browser, navigate to: Servers > PostgreSQL 8.4 > Databases > dycast > Schemas > public > Tables

• right-click existing effects_poly_centers_projected > Delete/Drop

• EPSG code for SAD69 UTM Zone 23S = 29193
http://spatialreference.org/

• Plugins menu > PostGIS Shapefile and DBF loader:

Shape File: effects_poly_centers_projected
SRID: 29193
Destination table: effects_poly_centers_projected
Geometry Column: [leave as “the_geom”] > Import

• Close window after import. Right-click Tables > Refresh
• Expand **effects_poly_centers_projected** > **Columns**:
  
  right-click **"gid"** > Properties > Name: change to **"tile_id"**
  right-click **"x"** > Delete/Drop > Yes
  right-click **"y"** > Delete/Drop > Yes

• close pgAdmin III.
Appendix IV. Protocol – DYCAST, ArcMap analysis

I. ADD DATA

1. Convert to .tsv

   - **Excel**: open DBF from geocoded humans shapefile. Reformat columns as follows (add “id” and “species” columns):

<table>
<thead>
<tr>
<th>id</th>
<th>onset_date</th>
<th>longitude</th>
<th>latitude</th>
<th>classi_fin</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1/4/1998</td>
<td>207049.01180548100</td>
<td>7658232.68130018000</td>
<td>1</td>
</tr>
</tbody>
</table>

   - Saves As > **Text (Tab delimited)**. It will save as a .txt file.

   - In DYCAST > **inbox** folder, duplicate **dycast_export_2008-04-04.tsv** file. Rename as **dycast_export_2010-04-05.tsv** and open up in WordPad or Notepad (Windows). Select all and delete everything.

   - Open up new .txt file in Notepad or Wordpad. Copy-paste everything into the .tsv file. Save file. [DYCAST can’t read anything but .tsv files]

2. Run DYCAST procedure.

3. **Note**: to add new humans (“birds”), open pgAdminIII > Tables > **dead_birds** > View Data > right-click row headers and **Delete**.

   This will automatically delete the same records from the **dead_birds_projected** table.

   Close the program and run DYCAST, selecting and loading birds as per usual.
II. ANIMATIONS

I. CREATE PERSONAL GEODATABASE [ArcCatalog]

1. within the folder viewer at the left, create new folder, DYCAST_RISK
2. right-click folder > New > Personal Geodatabase
3. Rename geodatabase based on risk model parameters:
   “600-100-4-28_TH05.mdb”
4. right-click geodatabase > Import > Feature Class (single)
   Input Features: dycast_rp_cells_n_71824.shp
   Output Feature Class: DYCAST_GRID
5. right-click geodatabase > Import > Table (multiple)
6. For “Input Table,” navigate to and select all the risk files:
   riskYYYY-MM-DD.dbf [may take awhile to load]
   click Add > OK
7. Open geodatabase. Right-click > Copy/Paste the first (earliest) risk file. This will be the target table in the following steps; rename this as:
   riskYYYY_MM_DD_to_YYYY_MM_DD [cannot use dashes in name]
8. ArcToolbox > Data Management Tools > General > Append:
   Input Datasets: select all the other tables from the new geodatabase (not the original dbf files, which will be displayed initially in the browser)
   Target Dataset: the target table from the previous step.
   Schema Type: TEST
9. Export table for use in accuracy calculation (RESULTS Notes)
   • right-click target table > Export > To dBase (single):
     Output Location: DYCAST_RISK folder
     Output Table: 600-100-4-28_TH10_risk2005-07-01_to_2007-04-09.dbf
II. ADD GEODATABASE TO TRACKING ANALYST  

1. Click the “Add Temporal Data” button: 

2. Select “A feature class and a separate table containing temporal data that this wizard will join to the feature class” (1)

3. For “Choose the input feature class” (2), navigate to geodatabase and select DYCAST_GRID

4. For “Choose the input table” (3), navigate to geodatabase and select the table with the appended years > risk2005_07_01_to_2007_04_18

5. For “Choose the field containing the data/time from:” (4), select:
   Or the input table: DATE_ [default]

6. Click “Next”

7. For “Choose the fields to base the join on:” (5), choose:
   Join Field in Input Feature Class: GRIDCODE
   Join Field in Input Table: ID

8. Click “Finish”

9. Repeat steps 1-8 for every other years/thresholds

III. ADD HUMANS IN TRACKING ANALYST

1. Click the “Add Temporal Data” button: 

2. Select “A feature class or shapefile containing temporal data.” (1)

3. For “Choose the input feature class” (2), navigate to and select the geocoded case shapefile

4. For “Choose the field containing the data/time from:” (3), select “onset_date”

5. Leave (4) as default, “<None>”

6. Click “Finish”
IV. SET PREFERENCES

1. Right-click temporal layer(s) and select: Properties > Symbology tab

2. In the “Show:” window at the top-left, check the “Time Window” box.

3. In the new “Time Window” box, type 28 for Period and select Days for Units > OK [for HUMANS; for risk do 1 day]
III. ANALYSIS

I. JOIN

- Create joined shapefile of humans with cells (one-to-one)

ArcToolbox > Analysis Tools > Overlay > Spatial Join:

Target Features: 08_FINAL_HUMANS...n_13546...ALL_FIXED
Join Features: DYCAST_RP_CELLS_n_71824
Output Feature Class: 08b_FINAL...WITH_CELLS.shp
[no dashes]
Join Operation: JOIN_ONE_TO_ONE
Match Option: IS_WITHIN

II. DATA

- ArcCatalog > export to DBF, then open in/convert to Excel .xls.

- sort RISK_TH10_7-01-05_to_6-30-2006 by ID then DATE_, both Ascending.

- copy/paste entire ID column to a new worksheet, then Data > Subtotals > Count (this will take awhile). This gives the number of days lit per cell, as well as a list of unique ID numbers for the subsequent lookup table.

- click on the “2” box at the very top-left to collapse the count records. Then copy/paste both columns into a blank Word document, then copy/paste these results back into Excel, in a new worksheet.

- Select column A and Find/Replace All “[space]Count” with “[blank]” to turn ID values back to numbers. Add “ID” as column A heading, and change column B heading to “DAYS_LIT”

- Save file, then Save As “…_STATS_FINAL”

- Insert a new column between ID and DAYS_LIT. Name it FIRST_LIT and fill the values with the formula:

=VLOOKUP(A2,[ID and DATE columns from original worksheet],2,FALSE)

which should read something like this:
=VLOOKUP(A2,'600-100-4-28_TH10_risk2005-07-0'!$A$2:$B$461596,2,FALSE)

*** remember to put the dollar signs in to lock the array!

This will grab the first date listed from the original page (which, since they’re sorted by ID then DATE, will be the earliest date lit). Change the cell format from number to date.

• copy-paste these three columns into a new workbook (i.e., “RISK_TH10” in the composite Excel file, “ACCURACY_STATS_”, as Values Only.

III. STATISTICS

• Run descriptive statistics using StatPlus stand-alone program (or Analysis Pak if running PC version of Excel) to calculate count, mean, std dev, max, and mode of DAYS_LIT. (watch out for check box denoting whether you’re including column title). Copy/paste results into Excel document next to raw data, then into compiled results worksheet, “STATS_FINAL”

• Make sure “DATA_08b_H_w_CELLS” worksheet is sorted by GRIDCODE then onset_date, both ascending.

• Create new B column in , “HUMANS_first onset”. Fill the values with:

  =VLOOKUP(A2,DATA_08b_H_w_CELLS!$A$2:$B$4691,2,FALSE)

  ...again, make sure to enter $ signs, and also that onset_date is column 2

• Change cell format to Date, then copy/paste result into a new column as Values Only. Delete original column with formulas.

• Sort column descending, and count number of “#N/A”’s. This is the value for the FALSE POSITIVES (b cell) in the 2x2 confusion matrix in STATS_FINAL worksheet.

• Sort RISK_TH10 data again but by ID, ascending. In DATA_08b_H_w_CELLS worksheet, add new B column, “TH10_first lit” and VLOOKUP values from respective (“RISK_TH10”) worksheet. Then duplicate column into new one as Values Only, then delete original.

• Sort by GRIDCODE then onset_date.
• Create DUPLICATE column K:

=IF(F2=F3,IF(B2=B3,0,"DUPLICATE_w_diff_ONSET"),)

to flag duplicate records.

• Create new C column, “TH10_days PRED”. Use formula:

=IF([DUPLICATE]2=0,[onset_date]2-[TH10_first_lit]2,"DUPLICATE")

such as:

=IF(K2=0,F2-D2,"DUPLICATE")

this will generate the # of days predicted for the first cases within a cell.

• Change the column cells’ format to Number with no decimal places, then copy/paste into new column as Values Only, delete original. Manually verify accuracy of values.

• Sort days PRED column Ascending. Color-code negative numbers (misses=false negatives) as red, zeroes and positive numbers (true positives) as green, ignore DUPLICATE’s (but count them to verify total), and #N/A’s as red (never lit=false negative)

Enter counts below column, transfer values to STATS_FINAL worksheet confusion matrix.

• Regarding the number of total cells: select dyecast cells that intersect street reference data with a 618.44 meter buffer (spatial domain + geocoding side offset. (N = 25,487 cells)

• TRUE NEGATIVES (d cell) in confusion matrix should be calculated as the remainder needed to bring total to 25,487 cells.

• Run descriptive statistics (StatPlus) on _days PREDICTED column for those predicted values (cells with 0 or positive values). Plot TH10 and TH5 on ROC graph.